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gMovie Version 1.4
Operating Instructions

Copyright 2001, Generic Media, Inc. All Rights Reserved

• generic media and gMovie are trademarks of generic media, inc.
• CLIE, PictureGear, Memory Stick and the Memory Stick logo are trademarks of Sony Corporation.
• Microsoft and Windows are registered trademarks of Microsoft Corporation.
• Graffiti, HotSync and Palm OS are registered trademarks, and Palm Desktop and the HotSync logo
are trademarks of Palm, Inc. or its subsidiaries.
QuickTime and the QuickTime logo are trademarks used under license. QuickTime is registered in the
U.S. and other countries.
All other trademarks are trademarks of their respective owners.
Before using this software, please read the Software License Agreement that is supplied with CLIE
handheld.

❒ Copying all or part of the contents of this software, sample images, and Operating Manual,
or renting the software are prohibited by copyright laws.
❒ The Company is not liable for damage or loss resulting from the use of this software, or for
any claim from a third party.
❒ The Company assumes no responsibility aside from the replacement of the media due to
manufacturing fault.
❒ This software must not be used in a system other than that specified.
❒ The software specifications may be subject to change without notice.
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Before Use

Features
gMovie is the application which enables the display and playback of
motion picture data with sound, made for the CLIE handheld by using a
Windows® application such as PictureGear Lite.
When you send movie data made for the CLIE handheld by PictureGear
Lite using HotSync operation, or copy the data to the CLIE handheld by
using a Memory Stick media, they are automatically registered to the
movie list of gMovie.
This Version (gMovie 1.4) supports playback of color movies, Jog Dial
control, and playback of data stored in a Memory Stick media.
<Precaution with Version 1.4>
• The CLIE handheld without audio-function can not play back the
sound, even if the file is with sound data.
• If the CLIE handheld is not adaptable to display in color, it is
impossible to view in color, even if the data is in color.
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Basic Operations

Starting gMovie
Select gMovie from the Home screen of the CLIE handheld by
rotating and pressing the Jog Dial navigator.
The gMovie application starts and the media (movie file) list appears.
Motion pictures that you can play back with gMovie are called "media."
z If no media file is installed, no list is displayed. To create a media file,
refer to "Creating a media file for gMovie using PictureGear 4.4 Lite"
(page 11).
If you use the CLIE handheld without the audio playback function,
you cannot play back the sound of a media file.
Movies stored in the Memory Stick
media are indicated with the
icon.

Media List
By rotating and pressing the Jog Dial
navigator you can select and play back
the media.
Details
Tapping this icon displays details of
the media.
Switchable information
[video] indicates the movie without
sound.
[audio + video] indicates the movie
with sound.*

Tapping these buttons toggles
the contents of switchable
information in four ways.
Name of Media item
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Switchable information : Tapping the following icon, displays of
contents change.
: displays the type of media item.
: displays the dimensions of the media item (pixels).
: displays the duration of the media item (seconds).
If the media file has many frames per second, the actual time
duration may be longer than that displayed.
: displays storage requirements (KB).
* If you use the CLIE handheld without the audio playback
function, you cannot play back the sound of a media file.
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Playing back a media file
Select the media file you want to play back from the Home screen of
CLIE handheld by rotating and pressing the Jog Dial navigator.
The media file is automatically played back.
Note
You can play back the media file by using the stylus to tap it.

Indicates the position of the playback
picture
Control with the Jog Dial navigator
Pause: Press the Jog Dial navigator during playback.
Restart playback: Press the Jog Dial navigator during the pause.
Scrolling still pictures: Rotate the Jog Dial navigator during playback or
pause.
Control with the stylus
Pause: Tap .
Restart playing back: Tap
Rewind: Tap

.

to return to the beginning of the media file.

Note
In normal playback mode, the playback of the same media file repeats.
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To return to the media list
Press the Jog Dial navigator more than two seconds and release it.
Or tap

at the upper-right corner of the display.

To play back the next media item
Press and rotate the Jog Dial navigator downward during media item
playback. Or tap

at the upper-right corner of the display.

To play back the previous media item
Press and rotate the Jog Dial navigator upward during media item
playback, or tap

in the upper-right corner of the display.

To play back all media items consecutively (Sequence Play mode)
Tap
for more than one second with the stylus. In Sequence Play
mode, the icon will change into
. To exit the Sequence Play mode,
tap
for more than one second.

To delete a media item

1

Display the media item to delete, then tap the Menu

2

Tap Delete.

3

Tap OK.

icon.

The media item will be deleted, and the display will return to the
media list.
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Miscellaneous

Menu Commands
Media menu
This menu is displayed by tapping the Menu
list is being displayed.

icon when the media

About gMovie
Version information of the gMovie application is displayed.
Power Off (only when the jog assist function is active)
You can turn the power off.
Find (only when the jog assist function is active)
Find screen is displayed.
This menu is displayed by tapping the Menu
item is displayed.

icon when a media

Details
Detailed information of active media item is displayed.
Beam Media
You can transmit the data of an active media item to another CLIE
handheld by using the Infrared(IR) port. For details of infrared
communication, see the Operating Instructions manual of your CLIE
handheld.
Note
It may take several minutes to complete infrared communication, depending on
the size of the media file.
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Delete
You can delete the active media item. When the Delete Media dialog box
is displayed, tap OK to perform deletion, or tap Cancel to cancel
deletion.
Preferences
s Loop movie playback
When the playback of the media item is finished, playback of the
same media item starts again.
Note
If you clear this check box, you cannot automatically play back the next
at the upper right corner of the display. Start the

media item by tapping
playback by tapping

.

About gMovie
Version information of the gMovie application is displayed.
Power Off (only when the jog assist function is active)
You can turn the power off.
Find (only when the jog assist function is active)
Find screen is displayed.
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Creating a media file for gMovie using
PictureGear 4.4 Lite
You can create a media file for gMovie using PictureGear Lite for
personal computers.
You can install PictureGear Lite to your computer from the install CDROM supplied with your CLIE handheld. For details on how to install
the application, refer to the this first manual of your CLIE handheld.
For details on how to use PictureGear Lite, refer to the online help “How
to use PictureGear Lite,” displayed by clicking the Help menu of
PictureGear Lite.

Movie (media) file formats you can use with PictureGear Lite
PictureGear Lite supports the following movie file formats:
• MPEG1 (file extension: .MPG, .MPEG)
• AVI (file extension: .AVI)
• QuickTime 3.0 and QuickTime 4.0 (file extension: .MOV, .QT)
Note
When using gMovie on your CLIE handheld, you may not be able to display some
AVI format files that do not conform to the Video for Windows standard.
The following explains how to send a media file created by PictureGear Lite to
your CLIE handheld.

Sending media files to a CLIE handheld using the HotSync
function
By resistering the media files you want to send in the PictureGear Lite
software, you can perform HotSync operation to send the movie files
from your computer to your CLIE handheld.

1

Select the slide (movie file) you want to send.
Click on a slide to select it. You can select multiple slides by holding
down the Ctrl or Shift key while clicking.

2

From the File menu, select Output services and then, Install
the image during the next HotSync.
The "Reserve to install on next HotSync" dialog box appears.
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3

Click V and select the recipient’s user name from the drop
down list.
If necessary, click Movie settings and make size and compression
settings for the movie file(s) you want to send in the "Detailed
settings for CLIE handheld movies" dialog box.
About the "Detailed settings for CLIE handheld movies" dialog
box
Select Compression Method
Selects the grayscale or color level for the movie file(s) you want to
send. Click to select Monochrome (High compression), Monochrome
(High image quality), or Color.
If your CLIE handheld is not adaptable for color, the display is not
expressed in color.
Size
Selects the dimension size of the movie file(s) you want to send.
Click to select 160 x 120, 120 x 92, or 80 x 60.
Dithering
When Monochrome (High compression) is selected in Select
Compression Method, you can use this slider to adjust the dither
level by dragging it to the left or right. You cannot use this function
on Monochrome (High image quality) and Color movies.
Sound Quality
Adjusts the sound quality for the movie files.
Select [None] when you use the CLIE handheld without the audio
playback function.
z The larger the Size or Sound Quality is, the larger the
movie file size will be.
Note
If you select still image movie files, the Settings for Still images dialog box
appears.

4

Click OK.
The selected movie files and their recipients are registered in
PictureGear Lite.
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5

Perform a HotSync operation between your CLIE handheld
and your PC.
The registered slide(s) are automatically sent to your CLIE handheld.
If the created movie file data is too large and exceeds the free
memory space of the CLIE handheld, an error message may appear
during the HotSync operation. To display a large size movie file
using gMovie, try using a Memory Stick media, as follows.

Copying movie files to a Memory Stick media
The following procedure explains how to copy slides (movie files) from
PictureGear Lite to a Memory Stick media, and to display them on a
CLIE handheld using gMovie.

1

Click to select the slide (media file) you want to display on a
CLIE handheld.
You can select multiple movie files by holding down the Ctrl or Shift
key while clicking.

2

From the File menu, select Output services and then, Output
CLIE handheld format file(s) to Memory Stick.
The "Output CLIE handheld format file(s) to Memory Stick" dialog
box appears.

3

Click V and select a Memory Stick media drive from the dropdown list.
Note
For the drive name of the Memory Stick media, refer to the instruction
manual of your personal computer.

If necessary, click Movie settings and make size and compression
settings for the movie file you want to send in the Detailed settings
for CLIE handheld movies dialog box.
About the Detailed settings for CLIE handheld movies dialog box
Select Compression Method
Selects the grayscale or color level for the movie file(s) you want to
copy. Click to select Monochrome (High compression), Monochrome
(High image quality) or Color.
If your CLIE handheld is not adaptable for color, the display is not
expressed in color.
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Size
Selects the dimension size of the movie file(s) you want to copy.
Click to select 160 x 120, 120 x 92, or 80 x 60.
Dithering
When Monochrome (High compression) is selected in the Select
Compression Method, you can use this slider to adjust the dither
level by dragging it to the left or right. You cannot use this function
on the Monochrome (High image quality) and Color movies.
Sound Quality
Adjusts the sound quality for the movie files.
Select [None] when you use the CLIE handheld without the audio
playback function.
z The larger the Size or Sound Quality is, the larger the movie file
size will be.
Note
If you select still image movie files, the Settings for Still images dialog box
appears.

4

Click OK.
The movie files converted to the gMovie format are copied to the
"\PALM\PROGRAMS\gMedia" folder in the Memory Stick media.

5

Insert the Memory Stick media into the CLIE handheld.
The movie files stored in the Memory Stick media are automatically
displayed in the gMovie list.
Note
If the movie file data written to the Memory Stick media is too large and
exceeds the free memory space of the CLIE handheld, the error message
“Data writing failed” may appear. Reduce and rewrite the data by trying one
of the following procedures.
1 Change to grayscale (to cut data size in half or less).
2 Reduce the movie size.
When you create a movie file, you can confirm the data size by selecting the
drive on your PC, such as C: drive. After writing the data to your PC drive
"C:\PALM\PROGRAMS\gMedia" (when you select C: drive), copy the data
to "the Memory Stick drive:\PALM\PROGRAMS\gMedia" folder on the
Memory Stick media, by using Explorer on your PC to display the movie file
on the CLIE handheld.
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